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1. Traducción asistida por ordenador (TAO). Memorias de traducción (MT) 

 

TAO = Traducción asistida por ordenador = CAT = Computer assisted translation = Traducir con la ayuda de 

programas que aceleran el proceso, especialmente memorias de traducción. 

Su uso ahorra tiempo, reduce costes y contribuye a la coherencia terminológica. Por ello, las agencias de 

traducción y algunos clientes exigen usarlos. 

Memorias de traducción = MT = bases de datos que almacenan oraciones originales junto con sus 

traducciones (realizadas por personas) con el objeto de reutilizarlas. 

 

Segmento original Segmento 

traducido 

Fecha 

traducción 

Traductor/a Cliente 
 

Unidades de 

traducción 

User Guide Manual del usuario 01/01/2011 Sara Apple ← 

Chapter 1 Capítulo 1 01/01/2011 Sara Apple ← 

iPod classic Basics Nociones básicas 

sobre el iPod 

classic 

01/01/2011 Sara Apple 

← 

Connecting and 

Disconnecting iPod 

classic 

Cómo encender y 

apagar el iPod 

classic 

01/01/2011 Sara Apple 

← 

... ... ... ... ... ← 

↑ ↑ ↑ ↑ ↑   

Campos   

 

Los sistemas TAO dividen los textos que vamos a traducir en segmentos (oraciones y títulos) y comparan 

cada uno de ellos con los segmentos originales de la memoria de traducción. Este es el aspecto de Trados 

Translator’s Workbench 2007, por ejemplo: 

 

 

← Memoria 

de 

traducción 

 

 

 

 

← Word  

u otro editor 

(aquí 

traducimos) 
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Equivalencia exacta (100 %; exact match): “User Guide”. El sistema propone “Manual del usuario”, 

previamente traducido por nosotros mismos u otro traductor. Si no nos gusta la traducción, la cambiamos; 

el cambio se almacenaría en la memoria. 

Equivalencia parcial (70 - 99 %; fuzzy match): “Connecting and Disconnecting iPhone 4S”. El sistema 

propone “Cómo encender y apagar el iPod classic” y debemos hacer los cambios pertinentes. El nuevo 

segmento se añadirá a la memoria con su traducción.  

Sin equivalencia (0 - 69 %; no match): “iPod classic at a glance”. El sistema no propone nada, ni siquiera 

“iPod classic”, puesto que entre el segmento nuevo y los almacenados en la memoria no hay una 

coincidencia mínima del 70 %. Debemos hacer nuestra propia traducción, que se añadirá a la memoria de 

traducción. 

Las memorias son muy útiles para: textos con oraciones que se repiten, textos que se actualizan 

periódicamente con pequeños cambios, páginas web, etc. 

Las memorias son poco útiles para: literatura y traducción editorial en general. 

 

 

2. Diferencia entre TAO y TA 

 

Traducción asistida ≠ traducción automática. 

En traducción asistida es el traductor humano quien traduce, reutilizando otras traducciones humanas 

cuando es posible. En la traducción automática es la máquina la que traduce. 

Casi todos los sistemas TAO permiten la conexión a programas de TA cuando las memorias no ofrecen 

equivalencias para un segmento. 

Los programas de TA basados en analogías (a diferencia de los basados en reglas) elaboran sus traducciones 

a partir de memorias de traducción elaboradas por humanos.   

 

 

3. Sistemas TAO 

 

SDL Trados 2007 (Translator’s Workbench + TagEditor + WinAlign + ...), el sistema más extendido en la 

actualidad. Se usa habitualmente con Word. Ya solo se vende con Trados Studio. 

SDL Trados Studio 2009 o 2011, el programa más completo, muy distinto de Trados 2007, una apuesta 

arriesgada que aún no se ha consolidado en el mercado. No se usa con Word, es un programa 

independiente (standalone). Cuesta entre 800 y 3200 euros; 450 para estudiantes. 

SDLX 2007, software original de la empresa SDL antes de adquirir Trados, Idiom, Passolo, etc. Es 

standalone. Ya solo se vende con Trados Studio. 

Wordfast Classic, comenzó como imitación del Trados clásico y distribuyéndose gratuitamente. Hoy es una 

alternativa barata a Trados (de 175 a 350 euros). También dispone de una versión standalone, Wordfast 

Professional. 

Wordfast Anywhere, versión online, sin instalación, gratuita y multiusuario. Muy buena opción para no 

perder la costumbre durante toda la carrera (incluso para hacer traducciones en grupo). ¿Acabará siendo 

de pago? 

Déjà Vu X2, el único hecho en España. Cuesta entre 300 y 1500 euros. 

OmegaT, el software libre de TAO más extendido. Tiene alguna limitación importante. Si se sabe gestionar 

bien las memorias, también es una buena opción para la carrera. 

Hay muchos otros: Star Transit, Across, memoQ, MetaTexis, etc. 
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4. Módulos habituales de los programas TAO 

 

A. Editor. En él vemos la oración original y escribimos la traducción. Está conectado a una memoria de 

traducción (MT) y a una base de datos terminológica (BDT). Con Trados 2007, el editor puede ser Word o 

TagEditor. 

 

SDL Trados Translator’s Workbench 2007 con Word (usado para traducir documentos doc o rtf) y 

con TagEditor (usado para traducir doc, rtf, html, etc.): 

 
 Conexión a MT 

↓ 

Conexión a BDT 

↓ 

Work-

bench → 

 

 

 

 

 

 

 

Word 

(editor)→ 

 
  

Conexión a MT 

↓ 

 

Conexión a BDT 

↓ 

Work-

bench → 

 

 

 

 

 

 

 

 

TagEditor 

(editor)→ 
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En los programas independientes (standalone), el editor, la memoria de traducción y la base de 

datos terminológica evidentemente están integrados. 

SDL Trados Studio 2009: 

 

 MT 

↓ 

BDT 

↓ 

 

 

 

 

 

 

Editor → 

 
 

B. Gestor de la memoria de traducción. Desde él podemos ver todas las unidades de traducción de una 

MT, modificarlas o borrarlas. Este es su aspecto en SDL Trados 2007: 
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C. Gestor terminológico. Permite crear bases de datos terminológicas y crear, modificar o eliminar datos 

en ellas. El que funciona con Trados se llama SDL MultiTerm: 

 

 
 

D. Gestor de proyectos de traducción. Permite crear, modificar y hacer el seguimiento de proyectos de 

traducción: contiene información sobre los archivos que se deben traducir, las MT y BDT que se van a usar, 

los idiomas implicados, las fechas de entrega, el número de palabras, etc.   
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E. Otros módulos: herramientas para alinear textos, convertir MT o BDT, analizar proyectos, pretraducir 

textos, crear diccionarios de texto predictivo, preparar formatos de archivo complejos, extraer 

terminología, etc.  

 

 

5. Diferencias entre MT y BDT 

Tanto las memorias de traducción como las bases de datos terminológicas son bases de datos, pero no 

deben confundirse. 

 

 Memoria de traducción (MT) Base de datos terminológica (BDT) 

entradas unidades de traducción (segmentos 

originales con sus traducciones)  

términos (con sinónimos y 

equivalentes) 

idiomas dos infinitos 

direccionalidad unidireccional multidireccional 

campos útiles traductor, fecha traducción, cliente definiciones, imágenes, colocaciones 

software SDL Trados Workbench (2007), Trados Studio MultiTerm 

formato 2007 tmw + 4 archivos mtw o sdltb 

formato 2011 sdltm sdltb 

se alimenta automáticamente conforme traduces manualmente 

¿imprescindible en 

TAO? 

sí no 

 

6. La segmentación del texto origen 

 

Segmentación: la división de un texto en unidades de sentido completas. Suelen ser oraciones, frases o 

títulos.  

Reglas de segmentación habituales de los programas TAO (se pueden modificar): un segmento acaba 

después de un punto pegado a la letra que lo precede y seguido de espacio, después de una marca de 

párrafo, después de dos puntos, signo de interrogación, etc.  

Listas de excepciones a las reglas de segmentación (también se pueden modificar): entre otras muchas, 

EE. UU., a. C., Dra. (en español), ggf., 11., z. B. (en alemán), Yahoo!, Mr., p. m. 

La importancia de la segmentación: si traducimos un texto con una segmentación distinta a la utilizada en 

la traducción previa de un texto muy parecido, el sistema apenas nos ofrecerá equivalencias. Ejemplos: 

 

Almacenado en la memoria: 

 

Llame al tel. 958 111 222 para más información.  For more information, call +34 958 111 222. 

Póngase en contacto con nosotros. Contact us. 

Nuestras sucursales. Our offices. 

 

Nuevas traducciones mal segmentadas, para las que el sistema no ofrece equivalencias por no 

existir una coincidencia mínima del 70 %: 

 

Llame al tel.  

958 111 222 para más información.   

Póngase en contacto con nosotros. Nuestras 

sucursales. 
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Debemos procurar que la segmentación sea razonable (un segmento = una oración), fusionando 

segmentos, dividiéndolos, haciendo listas de excepciones exhaustivas o en algunos casos cambiando las 

reglas de segmentación. En ocasiones incluso habrá que modificar el original. 

Sin embargo, la segmentación nunca debe condicionar nuestra traducción (con frecuencia conviene 

traducir dos oraciones originales por una sola o viceversa). 

Algunos clientes y agencias exigen que nunca se altere la segmentación. Ventajas: alineamiento perfecto 

entre oraciones, mayor probabilidad de encontrar equivalencias, menor coste. Inconvenientes: traducir 

medias oraciones es una barbaridad, la calidad de la traducción se puede ver resentida. 

 

 

7. El flujo de trabajo y la organización de archivos 

 

Cuando un traductor o una agencia de traducción comienza a tener una carga de trabajo considerable, 

conviene definir detalladamente la organización de los archivos y el flujo de trabajo (workflow). Por 

ejemplo: recepción del texto original; definición de fases, plazos y personal del proyecto; preparación del 

texto; traducción; revisión; maquetación; control de calidad; entrega; facturación. Cada una de estas fases 

podría ir acompañada de la correspondiente carpeta: 1_recepción, 2_proyecto, 3_texto_extraído, 

4_traducción, etc. 

 

Por supuesto, no existe una única manera de organizar el flujo de trabajo y los archivos implicados en un 

encargo. A continuación, proponemos una organización sencilla para un traductor freelance que trabaje  

con Trados 2007 (sin usar Trados Synergy): 

 
Traducciones 

 Clientes 

  Cliente 1 

   Proyecto 1 

    admin 

    memoria de proyecto 

    referencia 

    1_originales 

    2_bilingües 

    3_traducidos 

    4_revisados 

    5_finales 

 

   Proyecto 2 

    admin 

    memoria de proyecto 

    referencia 

    1_originales 

    ... 

  Cliente 2  

... 

 Glosarios 

 

 Memorias 

  Combinación idiomas 1 

   Temática 1 

   Temática 2  

    ... 

  Combinación idiomas 2 

... 

 Varios  

 

 

 

← proyecto sencillo hecho con Trados 2007 (sin Synergy) 

← creada por traductor si es necesaria; contiene presupuesto, factura, etc. 

← creada por traductor si es necesaria; contiene memoria entregada por cliente 

← creada por traductor si es necesaria; contiene textos paralelos o glosario específico del proyecto 

← creada por traductor; contiene originales sin modificar 

← creada por traductor; contiene bilingües bak o ttx 

← creada por traductor; contiene traducidos limpios 

← creada por traductor; contiene revisados bilingües  

← creada por traductor; contiene revisados limpios listos para entregar 

 

 

 

 

 

 

 

 

 

← creada por traductor; contiene glosarios sdltb no específicos de un proyecto 

 

 

 

← creada por traductor; contiene memorias 2007 tmw + 4 no específicas de un proyecto 

← creada por traductor; contiene memorias 2007 tmw + 4 no específicas de un proyecto 

 

 

 

← creada por traductor; contiene archivos útiles para más de un proyecto (diccionarios, correctores, etc.) 
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Carpeta “Traducciones”: una vez creada, no se debe mover; tampoco se debe cambiar el nombre de las 

carpetas superiores. 

Las carpetas correspondientes a las memorias, glosarios y correctores ortográficos deben ser 

independientes de las carpetas de los clientes y sus proyectos, puesto que todo lo que contengan puede ser 

usado en diferentes proyectos de diferentes clientes. 

Carpeta “Glosarios”: los nombres de los archivos que contenga deberían ser muy transparentes 

(en_es_fr_ar_juridico.sdltb, es_de_en_informatico.sdltb). 

Carpeta “Memorias”: es imprescindible crear una subcarpeta para cada combinación lingüística (una para 

en_es, otra para es_en, etc.), puesto que algunos sistemas TAO consultan todas las memorias contenidas 

en una carpeta. Los nombres de las memorias deberían ser transparentes: en_es_juridico.tmw, 

es_en_tecnico.tmx, ar_es_gral.sdltm. 

Carpeta “Varios”: solo es necesaria si usamos correctores ortográficos o diccionarios. 

Carpeta de proyecto: a partir de este nivel debe estar todo lo que pertenezca a un proyecto concreto y solo 

a ese proyecto. Si un archivo es útil para más de un proyecto (un glosario, por ejemplo), debe estar por 

encima de este nivel. Si un archivo solo es útil para un proyecto concreto (un texto paralelo, por ejemplo), 

debe estar en alguna de las carpetas subordinadas a la carpeta de proyecto. 

Carpeta “1_originales”: para los archivos originales. 

Carpeta “2_bilingües”: para los archivos bilingües que generan algunos sistemas TAO, como Workbench. 

Carpeta “3_traducidos”: para el primer borrador de la traducción, una vez limpiado. 

Carpeta “4_revisados”: para la traducción que contiene las sugerencias del revisor (es recomendable que 

las revisiones se hagan con cuidado sobre los archivos bilingües). 

Carpeta “5_finales”: para los archivos traducidos finales que se van a entregar al cliente. 

Carpeta “memoria de proyecto”: solo es necesaria si para un determinado encargo recibimos una memoria 

de traducción de proyecto, es decir, una memoria específica confeccionada para un proyecto concreto. 

Normalmente son los gestores de proyectos (project managers, PM) quienes preparan estas memorias, que 

contienen solo aquellas unidades de una MT más grande que coinciden en al menos un 70 % con algún 

segmento de los textos que debemos traducir. 

Carpeta “referencia”: solo es necesaria si, junto a los textos que debemos traducir, recibimos o buscamos 

algún material de referencia que pueda facilitar la traducción. 

Carpeta “admin”: para informes, presupuestos, facturas u otros archivos administrativos o comerciales. 

 

 

8. Práctica 1: traducción de archivos doc con SDL Trados 2007 

 

1. Para aprender a usar Trados 2007, traducirás un pequeño archivo sobre una impresora de la marca HP: 

descárgalo en inglés o francés. 

2. Crea una estructura de carpetas similar a la descrita más arriba y coloca el archivo original donde 

corresponda. Pega en la carpeta Glosarios las bases de datos terminológicas que tengas (descarga aquí 

una de ejemplo). Esta estructura de carpetas debe ser definitiva y servirte para los siguientes encargos 

de traducción. 

3. Si no los tienes instalados aún, instala los programas SDL Trados 2007 y SDL MultiTerm 2011. Para 

ninguno de los dos programas necesitas tener licencia, puesto que todas las actividades se pueden 

realizar en modo demo. 

4. Arranca MultiTerm y abre la base terminológica. 

5. Arranca Translator’s Workbench en Inicio > Todos los programas > SDL International > SDL Trados 2007 

> Trados > Translator’s Workbench (no uses el acceso directo a Trados Synergy que aparece en el 

http://www.ugr.es/~mvegaex/cartridges_hp_photosmart_pro_8300.doc
http://www.ugr.es/~mvegaex/cartouches_hp_photosmart_pro_8300.doc
http://www.ugr.es/~mvegaex/es_fr_en_comput.sdltb
http://www.ugr.es/~mvegaex/es_fr_en_comput.sdltb
http://www.ugr.es/~mvegaex/SDLTrados2007Suite_PRO_863.exe
http://www.ugr.es/~mvegaex/SDLMultiTermDesktop2011_SP1.exe
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escritorio) y, si el programa te lo pide, identifícate para que este pueda asociar tus traducciones a tu 

nombre. 

6. Crea una memoria de traducción nueva con la combinación lingüística adecuada y guárdala en la 

carpeta adecuada: File > New > etc. (Archivo > Nueva > etc.). 

7. Arranca Word 2007 o 2003 (no funciona con 2010)1 y abre el archivo original. Guárdalo en la carpeta 

correspondiente a los archivos bilingües. 

8. Una vez abiertos los tres programas, minimiza MultiTerm, coloca la ventana de Workbench en el tercio 

superior de la pantalla y la de Word en lo que queda libre. La pantalla debe tener este aspecto: 

 

 
 

9. Conecta Workbench con la base de datos terminológica: Options > Term recognition options > 

MultiTerm 9 > Browse > Add Termbase > Local termbases > Add > etc. (Opciones > Opciones del 

reconocimiento de términos > MultiTerm 9 > Examinar > Agregar > Bases de datos terminológicas 

locales > Agregar > etc.). 

10. Sitúa el cursor al comienzo del documento abierto en Word. Pulsa el botón . El programa abrirá el 

primer segmento y comprobará si hay traducciones o términos que te puedan facilitar el trabajo de 

traducirlo.  

11. Dentro de Word, el segmento abierto está dividido en dos campos, uno de color celeste para el 

segmento original y otro de color verde o amarillo para el segmento traducido. Traduce y pulsa la tecla  

. De esta forma cierras el segmento abierto [ ) ], envías tu traducción a la memoria de traducción 

[  ], abres el siguiente segmento [ ( ] y rescatas de la memoria una equivalencia total o parcial para el 

nuevo segmento, si es que la hay [  ]. Esa será la tecla que más uses a lo largo del proceso de 

traducción. 

                                                           
1
 Si no tienes Word 2003 o 2007, usa TagEditor en su lugar. Si tuvieras que traducir archivos docx con Trados 2007, no 

uses Word, sino TagEditor. 
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12. Para el segundo segmento Workbench ya nos ofrece una equivalencia parcial. La ventana de 

Workbench y los campos de Word tendrán un aspecto parecido a este. 

 

 
 

 

 

 
 

(Si no ves las marcas, pulsa la tecla ¶ en Word.) 

 

13. Haz los cambios que consideres oportunos en la traducción (en el campo amarillo) y pulsa la tecla  

para continuar traduciendo. 

14. Sigue traduciendo el documento del mismo modo. Poco a poco irá creciendo tu memoria de 

traducción.  

15. En algunos segmentos verás que Workbench resalta con una línea roja o azul algunas palabras de la 

oración original. Las líneas rojas marcan los términos que hay en la base de datos terminológica. Las 

líneas azules marcan elementos que el programa considera no traducibles (números, fechas, imágenes, 

etc.) y que simplemente debes transferir al lugar adecuado en la traducción. Usando las teclas 

 podrás transferir los términos (rojo) o elementos no traducibles (azul) al lugar 

apropiado del campo amarillo de Word. 
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16. Habrá muchas ocasiones en las que no haya coincidencias en la memoria de traducción, ni términos en 

la base terminológica ni elementos no traducibles. 

17. En ocasiones puede ser de ayuda consultar la memoria de traducción para ver cómo se ha traducido 

una palabra o secuencia de palabras. Para ello habrá que marcar las palabras en cuestión dentro del 

campo celeste de Word y pulsar la tecla de las concordancias: . Se abrirá una ventana nueva con 

todas las unidades de traducción de la memoria en las que aparezcan esas palabras. Esta es una función 

muy utilizada por los traductores profesionales, puesto que es una forma muy sencilla de mantener la 

coherencia terminológica. 

18. Una vez que hayas traducido todos los segmentos del documento de Word y no quede ningún 

segmento abierto, guarda los cambios y cierra el documento.  

19. El archivo que acabas de guardar es bilingüe, pues contiene tanto el texto traducido como el original 

(este último, con marcas delimitadoras y con formato de texto oculto, que solo se ven si pulsas la tecla 

¶ de Word). Evidentemente, así no se puede entregar al cliente y será necesario eliminar previamente 

el texto original. Para ello es imprescindible que el archivo esté cerrado; pulsa Tools > Clean up 

(Herramientas > Limpiar), selecciona el archivo bilingüe y pulsa Clean up (Limpiar). 

20. En la carpeta 2_bilingües habrá ahora dos archivos: uno con extensión .bak, que sigue siendo el archivo 

bilingüe y que debes dejar en esa carpeta; otro con extensión .doc, que es el archivo traducido limpio y 

que debes mover a la carpeta 3_traducidos. No limpies nunca dos veces el mismo archivo. 

21. Comprueba que el texto traducido está correcto y cotéjalo con el original. Ya está listo para ser 

revisado. 

22. Cierra todos los programas y crea un archivo comprimido que contenga todas las carpetas y archivos 

relacionados con la actividad.  

23. Es recomendable hacer esta práctica al menos dos veces y practicar haciendo traducciones de otros 

documentos teniendo en cuenta las siguientes indicaciones: 

a. Si Trados segmenta mal, usa los botones Ampliar segmento o Reducir segmento para 

remediarlo. También puedes usar Ampliar segmento si quieres traducir dos oraciones por una. 

b. Si mientras traduces descubres que has cometido un error en un segmento previo, debes 

proceder de la siguiente manera: cierra el segmento abierto con el botón , sitúate sobre el 

segmento que contiene el error, ábrelo, corrígelo, ciérralo con  y vuelve a abrir el segmento 

por el que ibas. 

c. Si por cualquier razón Word se queda bloqueado o el archivo traducido no funciona bien, 

desecha este archivo, vuelve a cargar el original y comienza de nuevo. La memoria ya contiene 

todas tus traducciones y en segundos volverás al punto en que te quedaste (usa el botón ). 

d. No es necesario guardar nada en Workbench. Conforme traduces y pulsas la tecla  todo se 

guarda en la memoria de traducción. Cuando acabes de usarlo, simplemente cierra 

Workbench. 
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e. No utilices nunca la tecla “deshacer” de Word después de haber pulsado alguno de los botones 

de la barra de herramientas de Trados en Word. 

f. Nunca puedes tener más de un segmento abierto. 

g. Nunca puedes cerrar Word con un segmento abierto. 

h. Nunca puedes limpiar un archivo si está abierto. 

i. Nunca debes comprimir archivos, memorias o bases de datos que estén abiertos. 

j. Una memoria de traducción de Trados 2007 consta de cinco archivos. Si borras cualquiera de 

ellos, la memoria no se abrirá. 

k. No borres nunca los archivos bilingües *.bak. Los necesitarás si detectas errores en la 

traducción después de haber limpiado: 1. desecha el archivo limpio; 2. cambia la extensión 

.bak por .doc; 3. abre el archivo y la memoria, abre el segmento que contiene errores, 

modifícalo y cierra el segmento con ; guarda el archivo y límpialo. 

l. Puedes ver las unidades de traducción almacenadas en la memoria desde File > Maintenance > 

Begin Search (Archivo > Mantenimiento > Iniciar búsqueda). Esto es el gestor de la MT. 

m. Si vas a traducir otros archivos con Trados, usa la misma memoria solo si la combinación 

lingüística y direccionalidad es la misma. 

n. Siempre que crees una memoria nueva, asegúrate de seleccionar correctamente el orden de 

los idiomas. Cambiar el orden de los idiomas de una memoria es muy complicado. 

o. El flujo de trabajo propuesto aquí está muy extendido entre traductores profesionales, pero 

evidentemente existen otras posibilidades: se puede usar TagEditor en lugar de Word, se 

puede crear un proyecto con Trados Synergy, se puede prescindir de MultiTerm, etc. 

p. En versión demo, no puedes abrir ninguna memoria que contenga más de cien segmentos. 

q. Si no aparecen las teclas de Trados en Word, debes cargar la plantilla manualmente: Opciones 

de Word > Complementos > Plantillas > Ir > Agregar > Trados8.dtom (está en C:\Program Files 

(x86)\SDL International\T2007_FL\TT\Templates). 

 

Videotutorial Workbench + Word (1)   

Videotutorial Workbench + Word (2) 

 

 

9. Gestores de terminología 

 

Base de datos terminológica = BDT = termbase (≈ glosario = glossary). 

El gestor de terminología es solo una de las muchas herramientas que se suelen usar en un entorno de 

traducción asistida. De hecho, podemos prescindir de esta herramienta si vamos a hacer una traducción 

con un sistema de TAO y no disponemos de un glosario. 

Un gestor terminológico permite crear glosarios o bases de datos terminológicas y crear, modificar o 

eliminar datos en ellas. El que funciona con Trados se llama SDL MultiTerm. 

Tanto las memorias de traducción como las bases de datos terminológicas son bases de datos, pero no 

debemos confundirlas. 

Aquí crearemos un glosario con MultiTerm. De esa forma, podremos disponer de un glosario cuando 

traduzcamos el siguiente encargo con Trados. 

 

 

  

http://dl.dropbox.com/u/5298968/Tutoriales/Tutorial_Trados_2007.swf
http://dl.dropbox.com/u/5298968/Tutoriales/Tutorial_Trados_2007_2.swf
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10. SDL MultiTerm 2011 

 

MultiTerm es el gestor de terminología de SDL. Permite crear glosarios que se integran perfectamente en 

Trados Workbench (2007) y en Trados Studio 2011. 

MultiTerm tiene una interfaz relativamente sencilla y cubre de sobra las necesidades de un traductor, pero 

para un terminólogo puede resultar una herramienta poco flexible. 

MultiTerm obliga a estructurar el glosario en torno a la jerarquía entrada > índice > término: cada entrada 

es un solo concepto, que se verbaliza en los idiomas (índices) que determinemos y para cada idioma 

tendremos la posibilidad de introducir un número ilimitado de términos bajo la misma entrada, siempre y 

cuando sean sinónimos o equivalentes. 

Antes de crear un glosario con MultiTerm es imprescindible decidir lo siguiente:  

a. los idiomas (campos de índice) con los que vamos a trabajar; 

b. los campos descriptivos que queremos añadir (definición, imagen, área de conocimiento, género, 

categoría gramatical, ejemplo de uso, fecha, colocaciones, revisado, observaciones, etc.); 

c. qué tipo de información vamos a introducir en cada campo (la definición o los ejemplos de uso 

deben ser texto libre, las áreas de conocimiento o el género gramatical deberían aparecer en 

picklists, la imagen necesariamente es un archivo, etc.); 

d. a qué nivel de la jerarquía entrada > índice > término queremos vincular cada uno de los campos (la 

imagen corresponde a la entrada, la definición al índice o idioma, el género al término, etc.). 

Una vez que hayamos introducido un solo término en MultiTerm será imposible hacer determinados 

cambios en la estructura, así que conviene tenerla clara desde el principio. 

Cada entrada en MultiTerm corresponde a un concepto, no a una palabra (como en los diccionarios). Es 

decir, en una entrada nunca debe haber más de un significado. Si una palabra es polisémica y queremos 

introducir más de un significado en el glosario, debemos crear tantas entradas como significados deseemos 

introducir. Dicho de otro modo, en un diccionario nos encontramos con que muchas entradas son 

polisémicas; en una base de datos terminológica, por el contrario, en muchas entradas nos encontramos 

sinónimos. Sociedad, por ejemplo, tiene varias acepciones; en el glosario debe haber al menos dos entradas 

distintas, una que iría acompañada del sinónimo empresa y de los equivalentes ingleses company, firm, etc. 

y otra que iría acompañada del sinónimo asociación y los equivalentes society, association, etc. (Incluso 

cuando todos los términos implicados en todas las lenguas compartan las mismas acepciones, debemos 

hacer una entrada por cada acepción).  

Cada campo de término debe contener un solo término (de una o varias palabras). Cuando deseemos 

introducir un sinónimo dentro de una entrada, siempre debemos hacerlo creando un nuevo campo de 

término. Por ejemplo, en una misma entrada aparecerán, uno debajo del otro, los términos sociedad 

limitada, sociedad de responsabilidad limitada, S. L., SL, S. R. L., etc. 

Un campo de término jamás debe contener entradas como devengado/a, devengado -a, devengado (a), 

empresa/compañía, UN (United Nations), puesto que así no aparecen casi nunca en los textos y el sistema 

TAO no las encontraría. No es necesario introducir formas masculinas y femeninas en el glosario, pues 

basta con una de ellas. En los demás casos debemos introducir dos términos distintos dentro del mismo 

idioma. Tampoco debemos escribir to en los infinitivos ingleses. 

Los términos deben escribirse con minúscula, excepto cuando las reglas ortográficas imponen otra cosa. 
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11. Práctica 2: creación, importación y exportación de glosarios con MultiTerm 

 

a. Creación de un glosario 

1. Abre MultiTerm 2011. 

2. Crea un glosario bilingüe o multilingüe. Uno de los idiomas debe ser el español; otro debe ser el inglés o 

francés. 

3. El glosario debe tener al menos los siguientes campos descriptivos: área temática, definición, imagen, 

género. Debes definir correctamente las propiedades de tales campos y ubicarlos en el lugar correcto 

de la estructura. 

4. Introduce al menos los siguientes términos: en inglés, print cartridge, tri-color, brook, cross country 

skiing, rate, warranty, copyright; en francés, cartouche d'impression, trichromique, ruisseau, ski de 

fond, tarif, garantie, copyright. 

5. No todas las entradas deben tener información en todos los campos. 

6. Al menos una entrada debe contener sinónimos. 

7. Al menos un término debe aparecer con la misma forma en dos entradas distintas.  

8. Antes de entregar tu trabajo, entra en Catálogo > Definition y comprueba que el glosario está 

configurado correctamente. 

 

b. Exportación de un glosario 

1. Crea una carpeta donde vayas a exportar el glosario desde Multiterm. 
2. Exporta el glosario creado en la actividad anterior a Excel (Catálogo > Exportar > Activar > Crear > 

Ejecutar exportación antes de cerrar). 
3. En la carpeta encontrarás un archivo XML. 
4. Abre el archivo en Excel (Datos > De otras fuentes > Desde importación de datos XML). 
5. Guarda ese archivo y crea otra carpeta. 
6. En la segunda carpeta exporta el archivo de Excel a CSV (Guardar como > Otros formatos > CSV). 
7. Abre el archivo con Word y separa cada celda con una tabla (Seleccionar todo > Insertar tabla > 

Convertir texto en tabla). Guarda el archivo como documento de texto. 
8. Comprime todos los archivos. La carpeta debe contener los siguientes archivos: un XML con el glosario 

de Multiterm; un XLS con el mismo archivo convertido a Excel; un CSV del mismo archivo; y DOC con el 
texto convertido en tabla. 
 
Videotutorial Multiterm a Excel/Word 

 

c. Importación de un glosario desde Word o Excel 

1. Abre el archivo glosariojurídico.doc 
2. Ahora convierte la tabla en texto siguiendo el procedimiento inverso (Tabla > Convertir tabla en texto) y 

guarda el archivo como texto (Guardar como > TXT) 
3. Ábrelo en Excel y alinea las celdas para que el texto se ajuste a su tamaño. Amplía también el ancho de 

columna. 
4. Guárdalo como XLS. 
5. Abre Multiterm Convert y selecciona Nueva sesión de conversión y Formato Excel. Tendrás que 

introducir como ubicación la carpeta donde esté el XLS. 
6. Corrige, si fuera necesario, los campos reconocidos por el programa. Continúa los pasos tal y como 

cuando creaste una nueva base de datos. 
7. El programa te habrá creado cuatro archivos (LOG, XML, XDT y XCD). 
8. Crea una nueva base de datos terminológica. Ahora, en lugar de cargar una plantilla predefinida, 

selecciona Cargar archivo de definición de base de datos terminológica existente y seleccionaremos el 
archivo XDT. 

9. Ve a Catálogo > Input y selecciona Default import definition. 

http://dl.dropbox.com/u/5298968/Tutoriales/BDT_y_export.swf
http://dl.dropbox.com/u/5298968/glosario%20jur%C3%ADdico.doc
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10. Procesa y selecciona Importación rápida. La BDT debería estar ya importada. Guárdala en otra carpeta. 
11. Comprime todos los archivos. La carpeta debe contener los siguientes archivos: un TXT de la tabla de 

Word; un XLS de la tabla convertida a Excel; los archivos generados por Convert (LOG, XML, XDT, XCD) y 
la nueva BDT (SDLTB) con todos sus archivos. 
 
Videotutorial Word/Excel a Multiterm 

 
 

12. Traducción de páginas web  

 

Las páginas web se pueden construir de muchas maneras distintas. También se puede proceder de muchas 

maneras distintas para traducirlas. 

Aquí simplemente traducirás una página web estática sencilla construida en lenguaje HTML. Antes de 

comenzar, conviene que recuerdes lo siguiente: 

a. Las páginas web son conjuntos de archivos (y datos) estructurados en carpetas e 

interrelacionados entre sí que se alojan en ordenadores conectados a internet y funcionan 

como servidores. Nosotros vemos el contenido de esos archivos a través de un navegador web 

(Internet Explorer, Mozilla Firefox, Google Chrome, etc.) de un ordenador conectado a internet 

que funciona como cliente. 

b. Al introducir en nuestro navegador una URL como, por ejemplo, http://www.ugr.es, aquel lo 

que hace no es otra cosa que recibir y mostrar el archivo principal de una carpeta asociada a 

esa URL de un servidor determinado. Ese archivo suele llamarse index.html (o index.htm, 

index.php, index.asp, etc.) y sirve de puerta de entrada a las páginas web. Al navegar y hacer 

clic en los enlaces que contienen, lo que hace el navegador es mostrar otros archivos. 

c. Los archivos html no contienen directamente las imágenes que vemos al navegar. Las imágenes 

son archivos independientes (*.jpg, *.gif, *.png, etc.) almacenados en las carpetas que 

componen la web y a los que se apunta desde los archivos html. Del mismo modo, desde estos 

archivos hay referencias a otros archivos  con diversas funciones: hojas de estilo que 

determinan el formato de una página (*.css), otros archivos html, archivos de vídeo (*.mov, 

*.avi, *.mpeg, etc.), archivos flash (*.swf), pequeños programas llamados scripts (*.js), 

programas complejos, etc.  

d. Incluso el texto que leemos en pantalla al navegar no necesariamente está contenido en los 

archivos html, pues puede proceder de otros archivos cualesquiera de la web a los que se haga 

referencia o de una base de datos vinculada (web dinámica). 

e. En otras palabras, lo que vemos en pantalla cuando navegamos por internet puede proceder 

simultáneamente de varias fuentes distintas. Es más, muchas páginas son únicas e irrepetibles, 

pues se construyen sobre la marcha a partir de los datos que introduzcamos en un formulario, 

de los datos de nuestro equipo, de los datos que contiene en ese momento una base de datos 

vinculada (es lo que ocurre en el webmail, por ejemplo), etc. 

f. Si descargamos todos los archivos de una web en nuestro ordenador respetando su estructura 

de carpetas (hay muchos programas que lo hacen), podemos desconectar nuestro ordenador 

de internet, navegar por ella sin problema... y traducirla sin problema. Eso es muy sencillo si se 

trata de una web estática (de contenido fijo, predeterminado), pero no tiene sentido si se trata 

de una web dinámica (que se genera cuando la abrimos). 

g. Si cambiáramos la ubicación o el nombre de cualquiera de los archivos o carpetas que 

conforman la estructura de archivos de una página web, o bien dejaría de verse correctamente 

o bien dejarían de funcionar algunos enlaces. Eso se debe a que las páginas web son conjuntos 

http://dl.dropbox.com/u/5298968/Tutoriales/tutorial_converter.swf
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de archivos interrelacionados: unos archivos hacen referencia a otros, para lo cual es 

imprescindible indicar correctamente su nombre, su extensión y su carpeta. 

h. Los archivos html o htm son documentos de texto plano muy sencillos. Se pueden abrir con 

cualquier editor, incluso con el Bloc de notas, para ver lo que se denomina el código fuente: las 

instrucciones en lenguaje HTML que el archivo da al navegador sobre la información y los 

archivos que debe mostrar en pantalla. Para que en pantalla se muestren correctamente las 

vocales acentuadas y otros caracteres inexistentes en inglés, es necesario que los archivos usen 

una codificación suficientemente amplia (por ejemplo, UTF-8).    

i. Traducir una página web implica que dentro del código fuente debemos discriminar el texto de 

aquello que es código en lenguaje HTML u otro lenguaje. El texto que debe traducirse suele 

estar en archivos con extensión htm o html, pero puede haber texto en muchos otros: js, php, 

asp, txt, css, xml, jsp, rss, etc. 

j. Al igual que ocurre en la localización de software, cuando la complejidad técnica de una web es 

excesiva para el traductor, suele requerirse la intervención de un ingeniero de localización, una 

persona con formación técnica y lingüística que extrae las cadenas de texto traducible, prepara 

los archivos para el traductor, le da instrucciones sobre cómo proceder e integra las cadenas 

traducidas en el producto final. Para traducir páginas web dinámicas, su intervención es 

imprescindible. 

k. El texto de las páginas web suele traducirse usando memorias de traducción. Sin embargo, el 

texto contenido en las imágenes (o en vídeos o archivos flash) debe tratarse de modo distinto. 

 

 

13. Práctica 3: traducción de una página web con SDL Trados 2007  

 

1. Debes traducir una pequeña página web: descárgala de aquí, descomprímela y analízala antes de 

comenzar a traducirla. 

2. Usa la misma estructura de carpetas de las actividades anteriores. Crea una nueva estructura de 

carpetas dentro del nuevo proyecto. 

3. Usa la misma memoria de traducción que en la primera actividad de Trados 2007. 

4. Arranca TagEditor y traduce cada uno de los archivos html correspondientes a la lengua origen que 

hayas elegido. Ten en cuenta lo siguiente: 

a. TagEditor solamente abre aquellas partes del documento que debes traducir, pero en 

ocasiones falla. Si abre un segmento de código, debes “traducirlo” por exactamente lo mismo, 

sin cambiar nada. 

b. En ocasiones, dentro del segmento original aparecen etiquetas de color gris: son trozos de 

código que TagEditor presenta de esta forma para no confundirlo con el texto. Es importante 

transferir estas etiquetas al lugar adecuado dentro de nuestra traducción. Para no confundir 

unas etiquetas con otras, conviene activar View > Tag Text > Complete (Ver > Texto de 

etiqueta > Completo). 

c. TagEditor trata las etiquetas como elementos transferibles no traducibles y por lo tanto las 

subraya en color azul. Para poder borrar una etiqueta en el campo de la traducción, antes 

debes desactivar Tools > Options > Protection > Protect tags (Herramientas > Opciones > 

Protección > Proteger etiquetas). 

d. TagEditor puede guardar los archivos de dos formas distintas: pulsando Save o Save Bilingual 

As... (Guardar o Guardar bilingüe como...) los guarda como archivos bilingües con extensión 

ttx; pulsando Save Target As... (Guardar destino como...) los guarda como archivos traducidos 

http://www.ugr.es/~mvegaex/web_en_fr.zip


18 Apuntes IAT. Universidad de Granada 

con la misma extensión que el original. También es posible generar los archivos meta 

limpiando los bilingües desde Workbench.  

5. Mientras traduces, averigua para qué sirven los botones de las barras de herramientas de TagEditor y 

las funciones del menú Workbench. 

6. Guarda los archivos bilingües y traducidos en sus respectivas carpetas. 

7. En la carpeta de los archivos traducidos, recrea exactamente la misma estructura que en la carpeta de 

los originales, sustituyendo estos por los traducidos. 

8. Comprueba que la web traducida se ve correctamente y que todos los vínculos funcionan igual que en 

la web original. Si no es así, probablemente se deberá a una de las siguientes causas: has cambiado el 

nombre de algún archivo o carpeta, o has cometido algún error con una etiqueta. En el segundo caso, 

debes desechar el archivo traducido que contenga el error, editar el bilingüe correspondiente con 

TagEditor y volver a generar el archivo meta. 

9. Utiliza la función File > Maintenance (Archivo > Mantenimiento) para eliminar de la memoria de 

traducción todos los segmentos que contengan exclusivamente código. 

10. Cierra todos los programas y crea un archivo comprimido que contenga todas las carpetas y archivos 

relacionados con la actividad.  

 

Videotutorial Workbench + TagEditor (1) 

Videotutorial Workbench + TagEditor (2) 

Videotutorial Workbench + TagEditor (3) 

Videotutorial Workbench + TagEditor (4) 

 

 

14. Práctica 4: funciones avanzadas y herramientas accesorias 

 

En grupo, responded a las siguientes preguntas de forma clara y concisa. No os limitéis a copiar respuestas 

de los manuales y demostrad que habéis experimentado con los programas y comprendéis las respuestas.  

 

1. Si tu actividad profesional habitual consistiera en la traducción directa de textos alemanes e ingleses 

sobre telefonía móvil y comercio de productos ópticos, ¿cuántas memorias de traducción crearías? 

Justifica tu respuesta. 

2. Cuando arrancamos Workbench, se abre automáticamente la última memoria de traducción utilizada. 

¿Cómo comprobarías que es la memoria de traducción que quieres utilizar/ampliar? 

3. ¿Cuál es la manera más sencilla de consultar cómo se ha traducido un determinado término en una 

memoria de traducción? 

4. ¿Qué ocurre si alteramos el valor mínimo de coincidencia de la memoria de traducción? ¿En qué se 

diferencia este del valor mínimo de coincidencia de las concordancias y del reconocimiento de 

términos? 

5. Imagina que después de trabajar en un proyecto de traducción has perdido los archivos 

correspondientes a la memoria de traducción pero conservas el archivo bilingüe sin limpiar. ¿Cómo 

podrías recuperar la memoria de traducción sin gran esfuerzo? 

6. Trados por defecto convierte en dos segmentos una oración dividida por el signo ortográfico “:”. ¿Cómo 

puedes cambiar esa regla? 

7. Si Trados convierte una oración en dos segmentos, lo más sensato es corregirlo. ¿Cómo lo haremos 

cuando el error está motivado por una marca de párrafo errónea? ¿Qué haremos para evitar errores de 

segmentación motivados por puntos de abreviaturas?  

8. ¿Para qué sirve el programa WinAlign? 

http://dl.dropbox.com/u/5298968/Tutoriales/TagEditor.swf
http://dl.dropbox.com/u/5298968/Tutoriales/TagEditor2.swf
http://dl.dropbox.com/u/5298968/Tutoriales/TagEditor3.swf
http://dl.dropbox.com/u/5298968/Tutoriales/TagEditor4.swf
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9. Imagina que un cliente te pide que corrijas algunas oraciones en una página web que tradujiste para él 

hace tiempo. Describe detalladamente cómo deberías proceder para corregir tales errores en un 

archivo html de tal forma que las correcciones queden recogidas también en la memoria de traducción 

que generaste. 

10. En una memoria de traducción muy extensa en la que hayan intervenido varios traductores, ¿cuál es la 

manera más fácil de revisar los segmentos traducidos por uno de ellos? 

11. Enumera las desventajas de la traducción asistida frente a la traducción “tradicional”. 

12. ¿Cómo puedes modificar la estructura de una base de datos terminológica ya existente en MultiTerm? 

13. ¿Qué es un input model en MultiTerm? ¿Cómo se crea? 

 

15. Los proyectos de traducción en Trados Studio 

 

Un proyecto de traducción es un archivo que recoge toda la información relevante sobre un determinado 

encargo de traducción: los nombres de los archivos originales y su ubicación, la carpeta donde deben 

guardarse las traducciones, los nombres y las ubicaciones de la MT y la BDT, etc. 

Dependiendo del sistema  de TAO que utilicemos, será necesario o no crear un proyecto de traducción. Con 

OmegaT, Déjà Vu, Trados Studio o cualquier otro sistema independiente, es imprescindible; además, suele 

ir acompañado de una estructura de carpetas fijada por el programa. Con Trados 2007 no es necesario 

crear un proyecto ni usar una estructura de carpetas predeterminada, a no ser que usemos Trados Synergy 

(poco recomendable). 

Al usar programas TAO, debemos tener mucho cuidado con las estructuras de carpetas, pues dependiendo 

de cómo los usemos, crearán sus propias estructuras o no: 

 Si usamos Trados 2007 tal y como se indica en estos apuntes, este programa no crea carpetas y en 

cada momento debemos indicar dónde queremos guardar los archivos generados. (Trados 2007 

tiene un gestor de proyectos llamado Trados Synergy 2007 que sí genera su propia estructura de 

directorios). 

 Si usamos Trados 2011 tal y como se indica en estos apuntes —es decir, usando la opción de New 

Project (Nuevo proyecto)—, este programa sí crea una estructura de directorios. No podemos 

cambiar los nombres de las carpetas que el programa crea ni los de las carpetas superiores, pues el 

proyecto dejaría de funcionar correctamente. Pero nada nos impide completar la estructura de 

directorios con aquellos que nos convengan. 

 Si en Trados 2011 usamos la opción de Open Document (Abrir documento), el programa no crea 

carpetas. En ese caso, lo utilizaremos del mismo modo que TagEditor. Solamente conviene hacerlo 

cuando el encargo consista en traducir un solo archivo. 

 OmegaT por defecto crea una estructura de directorios, pero nosotros podemos cambiarla y 

adaptarla a nuestras necesidades.  

La estructura de carpetas que genera Trados Studio 2009 o 2011 cada vez que creamos un proyecto nuevo 

se puede integrar perfectamente en una estructura como la propuesta más arriba y se puede completar 

con nuevas carpetas que permitan seguir con facilidad el flujo de trabajo: 
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Traducciones 

 Clientes 

  Cliente 1 

   Proyecto x  

    es_ES 

    fr_FR 

    reports 

    admin 

    referencia 

    1_originales 

    2_bilingües 

    3_traducidos 

    4_revisados 

    5_finales 

    tm 

 

 

   Proyecto y 

    admin 

    memoria de proyecto 

    referencia 

    1_original 

    2_bilingüe 

    3_traducido 

    4_revisado 

    5_final 

 

    ... 

  Cliente 2  

... 

 Glosarios 

 

 Memorias 

  Combinación idiomas 1 

   Temática 1 

   Temática 2  

    ... 

  Combinación idiomas 2 

... 

 Varios  

 

 

 

← proyecto sencillo hecho con Trados 2011, con New Project (p. ej., fr>es); contiene proyecto sdlproj 

← carpeta creada por T2011; contiene traducidos y bilingües sdlxliff llenos 

← carpeta creada por T2011; contiene originales y bilingües sdlxliff vacíos 

← carpeta creada por T2011; contiene informes xml (se deben abrir desde T2011) 

← creada por traductor si es necesaria; contiene presupuesto, factura, etc. 

← creada por traductor si es necesaria; contiene textos paralelos o glosario específico del proyecto 

← creada por traductor; contiene originales sin modificar, sin bilingües (carpeta prescindible) 

← creada por traductor; contiene copia de bilingües sdlxliff llenos 

← creada por traductor; contiene copia de los archivos traducidos sin bilingües 

← creada por traductor; contiene bilingües sdlxliff revisados 

← creada por traductor; contiene revisados en mismo formato que originales 

← carpeta creada por T2011 si usamos la secuencia de tareas Prepare (Preparar); contiene memoria de 

proyecto (solo recomendable cuando no interesa usar memoria principal) 

 

← proyecto de un solo archivo hecho con Trados 2011, con Open Document; contiene proyecto sdlproj 

← creada por traductor si es necesaria; contiene presupuesto, factura, etc. 

← creada por traductor si es necesaria; contiene memoria entregada por cliente 

← creada por traductor si es necesaria; contiene textos paralelos o glosario específico del proyecto 

← creada por traductor; contiene original sin modificar 

← creada por traductor; contiene bilingüe sdlxliff 

← creada por traductor; contiene traducido 

← creada por traductor; contiene bilingüe sdlxliff revisado 

← creada por traductor; contiene revisado en mismo formato que original listo para entregar 

 

 

 

 

← contiene glosarios sdltb no específicos de un proyecto 

 

 

 

← contiene memorias 2011 sdltm no específicas de un proyecto 

← contiene memorias 2011 sdltm no específicas de un proyecto 

 

 

 

← contiene diccionarios autosuggest bpm u otros archivos útiles para más de un proyecto 

 

A partir del nivel “proyecto x” debe estar todo lo que pertenezca a un proyecto concreto y solo a ese 

proyecto. Si un archivo es útil para más de un proyecto (un glosario, por ejemplo), debe estar por encima 

de este nivel. Si un archivo solo es útil para un proyecto concreto (un texto paralelo, por ejemplo), debe 

estar en una carpeta subordinada a la del proyecto.  

No podemos cambiar los nombres de las carpetas que el programa crea ni los de las carpetas superiores, 

pues el proyecto dejaría de funcionar correctamente. 

 

16. Práctica 5: traducción con SDL Trados Studio 2011 

 

1. Vas a traducir dos archivos muy similares a los de la práctica 1: descárgalos en inglés o francés y 

descomprímelos. 

2. Usa la estructura de carpetas de las actividades anteriores. Solo debes crear la carpeta 

correspondiente al nuevo proyecto. 

3. Si no lo tienes instalado aún, instala el programa SDL Trados Studio 2011 sin cambiar las opciones de 

instalación (ojo, podrás usar el programa solo durante 30 días). Es preferible que instales la interfaz de 

usuario en inglés (Ver > Idioma de la interfaz de usuario > English). 

http://www.ugr.es/~mvegaex/en_hp.zip
http://www.ugr.es/~mvegaex/fr_hp.zip
http://www.ugr.es/~mvegaex/SDLTradosStudio2011_SP1.exe
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4. Descarga el diccionario correspondiente a la combinación de idiomas que hayas elegido en la carpeta 

Varios: en-es o fr-es. 

5. Arranca SDL Trados Studio 2011. 

6. Crea un nuevo proyecto de traducción: File > New > Project (Archivo > Nuevo > Proyecto). En las 

siguientes pantallas, usa estas configuraciones: 

i. Project Type (Tipo de proyecto): Default. 

ii. Project Details (Detalles del proyecto): elige un nombre para tu proyecto y selecciona la 

carpeta que acabas de crear. 

iii. Project Languages (Idiomas del proyecto): elige inglés o francés como lengua origen y español 

como lengua meta. 

iv. Project Files > Add Files (Archivos del proyecto > Agregar archivos): escoge los que acabas de 

descargar. Independientemente de dónde estén, Trados creará una copia de los mismos 

dentro de la carpeta del proyecto. 

v. Translation Memory and Automated Translation (Memoria de traducción y traducción 

automática): 

a.  Add > File-based Translation Memory (Agregar > Memoria de traducción basada en 

archivos): selecciona la memoria *.tmw de la práctica 1 (y 3) y dale a Quick Upgrade > 

Close (Actualización rápida > Cerrar). 

b.  Add (Agregar) > Google Translate (si no funciona, usa un sistema de TA gratuito de 

SDL). 

c.  En English -> Spanish o French -> Spanish > Autosuggest añade el diccionario que te 

acabas de descargar. 

vi. Termbases (Bases de datos terminológicas): elige la misma que hiciste en la práctica 2. 

vii. SDL PerfectMatch: no añadas ningún archivo. 

viii. Siguientes pantallas: deja las opciones predeterminadas. 

7. Observa las carpetas y archivos que Trados ha creado dentro de la carpeta del proyecto y de la 

memoria. El archivo *.sdlproj es el proyecto de traducción que acabas de crear y contiene toda la 

información relativa al  archivo original, carpetas, memoria, etc. Los archivos *.sdlxliff son los archivos 

bilingües que todavía no contienen la traducción. El archivo *.sdltm es la memoria de traducción 

convertida al formato de Trados Studio 2011. 

8. En la pestaña Files (Archivos), haz doble clic sobre el primer archivo que quieras traducir. 

9. Escribe tus traducciones en la columna de la derecha y confírmalas cada vez con Ctrl + Intro. De esa 

forma se añaden a la memoria de traducción *.sdltm (no a la memoria *.tmw). 

10. En la pestaña Files (Archivos), haz doble clic sobre el segundo archivo y tradúcelo. Averigua cómo 

funcionan el reconocimiento de términos, la transferencia de elementos no traducibles, la 

previsualización, el diccionario autosuggest, los formatos, las concordancias... Usa el manual de Trados 

si lo necesitas. 

11. Cuando hayas acabado las dos traducciones, pulsa Project > Batch Tasks > Finalize (Proyecto > Tareas 

por lotes > Finalizar) y sigue los pasos que indica la pantalla. 

12. Comprueba que los textos traducidos están correctos y cotéjalos con los originales.  

13. Cierra todos los programas y crea un archivo comprimido que contenga todas las carpetas y archivos 

relacionados con la actividad.  

14. Es recomendable hacer esta práctica al menos dos veces y practicar haciendo traducciones de otros 

documentos teniendo en cuenta las siguientes indicaciones: 

a. Si Trados segmenta mal, usa las funciones Merge Segments o Split Segment (Fusionar 

segmentos o Dividir segmento) para remediarlo. También puedes usar Merge Segments 

(Fusionar segmentos) si quieres traducir dos oraciones por una. 

http://www.ugr.es/~mvegaex/en_es.bpm
http://www.ugr.es/~mvegaex/fr_es.bpm
http://www.ugr.es/local/mvegaex/SDLTradosStudio2011forTranslators-GettingStarted.zip
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b. Nunca debes comprimir archivos, memorias o bases de datos que estén abiertos. 

c. Una memoria de traducción de Trados 2011 consta de un solo archivo.  

d. No borres nunca los archivos bilingües *.sdlxliff o *.sdlproj. 

e. No cambies la ubicación ni el nombre de ninguna de las carpetas relacionadas con un proyecto 

de traducción, pues de lo contrario dejará de funcionar. 

f. Puedes ver las unidades de traducción almacenadas en la memoria abriéndola en el gestor de 

la MT (la pestaña Translation Memories, Memorias de traducción). 

g. Si vas a traducir otros archivos con Trados, usa la misma memoria solo si la combinación 

lingüística y direccionalidad es la misma. 

h. Siempre que crees una memoria nueva, asegúrate de seleccionar correctamente el orden de 

los idiomas. Cambiar el orden de los idiomas de una memoria es muy complicado. 

i. El flujo de trabajo propuesto aquí es el más cómodo si un proyecto de traducción consta de 

más de una archivo. Para un proyecto de un solo archivo, es más cómodo empezar por File > 

Open > Document (Archivo > Abrir > Documento). 

j. Si un proyecto consiste en la traducción de dos o más archivos, una vez acabado el primero, 

debemos acceder a la pestaña Files (Archivos) para abrir el siguiente, no al menú File > Open > 

Document (Archivo > Abrir > Documento) ni al botón Open Document (Abrir documento). Al 

usar esta otra opción crearíamos un nuevo proyecto. 


